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Highlights
Some of the most important enhancements in GibbsCAM 2025 are as follows:

. #8GibbsCAM Copilot — An Al-powered chat tool to help users solve problems
interactively. For details, see “GibbsCAM Copilot: Al-powered chat tool”.

Op Tile List — For MTM models, new Op tile list buttons £ £ Zlet you set the
mode for displaying flows. For details, see “New modes for Op Tile List: Columns for

flows”.

This “Highlights” section is just a small subset of the enhancements in GibbsCAM 2025.
The next section (Overview of What’s New) provides a complete list.

Overview of What’s New

Enhancements to Milling include:

+  Mill > Holes > Mill Feature: With Top Surface Z choice Automatic, you can now specify
an incremental offset that will be applied to all selected features.

«  Mill > Roughing: For Pocket toolpath, you can now optionally machine pockets in
the order they were selected.

+  Mill > Lead-In / Lead-Out: New options for lead-in and lead-out let you combat tool
deflection by cutting past the edge of the material.

* A new plug-in, up2parts autoCAM, lets you import upzparts bundles that contain
proposals and recommendations for machining steps, operations, and tools.
Importing the bundle generates processes, operations, and toolpath that you then
refine using GibbsCAM.

For details, see “Milling”.
Enhancements to Turning include:

*  Roughing: A new choice for Rough Type, Rib Cut, reduces tool deflection and
improves tool life.

+  Swiss-style machines now support sliding headstocks and Z axis limits.
For details, see “Turning’”.

GibbsCAM 2025 has many enhancements to Visualization and User Interface:




GibbsCAM Copilot: An Al-powered chat tool helps you solve problems
interactively.

*  Op Sim and Machine Sim now provide graphics to indicate spindle direction for
both tool and part.

A new Edit > Selection menu option, # Filter Selections, can help you to refine
your geometry selections, opening a dialog that lets you include/exclude various
kinds of points, lines, circles, curves, text, PMI, etc., for overlap mode or mouse
drag.

»  In Machine Sim, ¥ Collision Checking and Program Error Check are now
enabled by default for newly created parts.

* In Op Sim, Analyze Cut Part now lets you supply a value for Tolerance.

cc =
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+ Op Tile List — For MTM models, new Op tile list buttons = =let you set the
mode for displaying flows. You can redraw toolpath in one easy action: Simply
Ctrl+click or Shift+click an operation tile. In Op Sim and Machine Sim, you
can set a new Stop type: Stop Before Every Operation. When Simulation is running, the
Sync Control dialog provides a graphical indicator (a moving red bar) that shows
the progress of the simulation as it executes.

For details, see “Visualization and User Interface”.

Improvements to Tooling:

+ Additional tool cutting parameters like Ae (Cut Depth) and Ap (Cut Width) can be
stored with tool cut data.

* Alink in the Tool dialog, & Qrder tool appears when the current tool is known to
be available from a supported tool library manufacturer, so that the tool can be
ordered immediately.

For details, see “Tooling”. Also see “Turning’”.
Improvements to Posting and Output:
«  TMS now supports full WFO system functionality.

+  Postprocessors can now query and output programmed machining tolerance for
operations on solids.

For details, see “Posting and Output”.

Enhancements to Solids include:

+  Ability to edit facet bodies: Boolean, offset/shell, History, heal, refacet, tessellate,
and more.




Collision avoidance of workspace fixtures and Intermediate Fixtures.
For details, see “Solids”.
Miscellaneous improvements and changes:
Copying/pasting of solids now preserves colors and other attributes.
NLO now allows License borrowing with checkout/return capabilities.
Op Manager and Process Manager support VoluMill data fields.
Op Manager and Process Manager support many 5-Axis data fields.
MDDs can now set maximum spindle RPM for parts and tools.
VoluMill 9.6 is now supported

For details, see “Miscellaneous”.

Improvements to 5-Axis:
Integration of ModuleWorks 2024.04, 2023.12, and 2023.08.

«

For details, see “5-Axis”.




Milling

Milling

GibbsCAM 2025 includes several important Milling enhancements.

Mill Feature > Top Surface Z=Auto: Auto+
value for incremental offset

Where to find it:Mill > ... > Mill Feature tab; for Top Surface Z, choose Automatic: Auto+
textbox.

In Milling processes that have Mill Feature tab, when Top Surface Z is Automatic, you can
enter a value in the Auto+ textbox that provides a global incremental value above the
detected Top Surface Z.

Process #1 Contour 0@% IF. - %

Contour Mill Feature | Solids | Open Sides| offset | Entry/Exit| Rotate|

Approach Z: () Depths from Feature
Absolute L i Depths from Tool
1l 52 lj 52 1
Retract Z: B rapid In

Top Surface Z:

Automatic e
This replaces the previous interface, where the value in the Automatic textbox was
automatically o.




Milling

Pocket / Contour: Ability to machine pockets
in selection order

Where to find it:Mill Roughing/Contouring, left tab: Mach. Order pulldown option From
Selection.

In Milling processes Roughing (Pocket tab) and Contour (Contour tab), you can now
instruct the system to create toolpath in the order of the user’s selections. The previous
option (Automatic) instructs GibbsCAM to determine the order.

Pocket | Mill Feature | Solids | Open Sides| Offset/Trim | Entry/Exit | Rotate |

Offset v () Depths from Feature

Depths from Tool
Tool |:| Material @pep
1 21 l i 2.1 1
Speed: RPM 8500

[ ]rapid In A_E 0°

e s
. - ]+ 1.4
Contour Feed - /

(®) Line 0.05 Desired Actual # Passes
() 90° Line Retracts Depth First Prefer Subs
) Advanced Do not hit flats e
Pocket Stock 0.01

Ramp... w
sadsoks [0 |

Mach. Order
Z Stock 0.01
Crverlap

CRC On Climb
I+ Coolant

Spring Passes

Il

Lead In / Lead Out: Open Sides > Overlap
Finish Walls

Where to find it:In Mill process dialogs, with Material Only: Open Sides textbox Overlap
Finish Walls.




Milling

In all Milling processes, a new parameter when Material Only is enabled lets you cut
past the edge of the material, recutting a short section of the finish wall. (The value o,
meaning “no overlap”, is the previous and default behavior). You can use this to combat
tool deflection and increase tool life.

Process #2 Contour %IF - %

Contour | Mill Feature| Soids Open Sides | Offset | Entry/Exit| Rotate |

Minimum Cut 0,0005
Cverlap Finish Walls _I

2

= Plug-In: up2parts AutoCAM

The up2parts AutoCAM plug-in lets you import upzparts *.zip files and use the results to
generate GibbsCAMoperations, toolpath, simulation, and G-Code.

Workflow: On the up2parts Website

The following steps can be done by anyone familiar with upzparts, not necessarily a
GibbsCAM user.

1. The user supplies credentials to the up2parts website and then uses up2parts to:

a. Specify a solid model in STEP format. Note that AP242 includes PMI and
tolerance information, but AP203 and AP214 do not.

b. Start the up2parts geometry analysis and Al-based feature recognition.

c. Get a technical description that includes recognized features like pockets, holes,
countersinks, and surfaces.

4. Then, up2parts calculation is used to generate a work plan by defining the machine,
material specification, and general tolerance (ISO-2768).

5. Next, upz2parts proposes a CAM project for six-sided machining that includes
“clamping” (approach from top/bottom/left/right/front/back), tools, machining
steps, and operations. The up2parts interface allows adjustments and refinements to
this proposed project.

6. After the project is confirmed, up2parts bundles its proposals and recommendations
into a *.zip file readable by GibbsCAM. This .zip file includes: the solid model in
STEP format with complete feature tree; stock information; tooling; features with
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Milling

operations; and meta information for clamping. Associated PMI (product
manufacturing information), if any, is preserved.

Workflow: Within GibbsCAM

Before you begin:Set the units in your DCD to match the units of the upzparts bundle
(usually mm).

1. On the Plug-Ins menu, under Main Tools, click up2parts autoCAM.

2. In the up2parts program arguments dialog:
(for Selected file): Supply the *.zip filename of the bundle prepared by up2toparts.
(for Select clamping): Select a folder to specify approach:
top/bottom/left/right/front/back.
Click Import.

3. Notice that progress is shown by status bar at the bottom of the GibbsCAM window.
When the import process is complete, GibbsCAMdisplays the model in the
workspace. Then, watch as features are processed and operations are generated.
Finally, in response to the message “The part is loaded and processes/operations
have been created”, click OK.

4. You can inspect and optionally modify any aspect of the GibbsCAM model,
including tooling, processes, parameter values, and operations. You can then use any
of the native GibbsCAMSimulation options to visualize the machining operations
and to find/correct any toolpath issues.

5. Use the appropriate GibbsCAM postprocessor to generate G-Code for your specific
machine.
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Turning

Turning

Roughing > Rib Cut

Where to find it:Turning > Rough; for Rough Type, choose Rib Cut
Plunge.

This new Turning strategy consists first of a preliminary pass
where the tool repeatedly plunges into the part at full
engagement to create a series of cuts with each cut more than a
tool-width away from the previous one. Then the next pass cuts
the remaining “ribs”. Rib cutting avoids tool deflection in both
passes, and it offers excellent chip control. The rib cuts can be
made safely at high speed to decrease the total amount of cycle
time.

Process #1 Rough

Roughing |
®oD
[ Forward O FrontID
[]5quare Corners (O Front Face
[IBack & Forth

Rough Type  |Rib Cut Plunge
Turn

Plunge
Pattern Shift

{

o (4

[CJreverse Rib Direction
[IMax Rib width | 0.192

Rib Cut Feed %

Rib Cut Speed % | 150
Main Cut Peck

Peck Retract

Peck Full Out
Peck Retract

( Ii

Plunge |

Rib Cut Peck
Peck Retract e
Peck Full Qut

Plunge
Peck Amount

ER
[~]Rretract Feed ipr
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Turning

Swiss-style machines: Sliding headstocks and

Z-axis limits

Where to find it:In Machine Manager, for node type "7 F (lathe spindle): ¥ Headstock

Origin.

[=--mdd Training Swiss [1P2T-25]
=4, 7101
=, C101
_.[B P1 (Main Spindle)
a4, X2
LB T2V Turret)
=4, X102
2 Ay Z102
=-d, clo2
.08 P2 (Sub Spindle)
a4, X1
E|_|]' V1
B T (X Turret)
== T3 (3-5pin U
-1 \

Training Swiss [1P2T-25]

Part Statiocn  Orientation

Spins Part
[ ] Max RPM 0

Stock
Cubic

Cylindrical

Part Defined

Has Guide Bushing

Headstock Crigin I

Z Min

The new Headstock Origin checkbox lets you provide a value for the distance between the
front of the guide bushing and your headstock’s o position. This lets you correctly
position Simulation bodies on the headstock axis, and it provides a more intuitive
interface in the DCD for Swiss-style machines.
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Visualization and User Interface

Visualization and User
Interface

EGibbsCAM Copilot: Al- > @ |

Contents Getting On ltem

powered chat tool Started
B
E =
Where to find it:On the Help menu, click & PDFs  Online g
GibbsCAM Copilot. rainingg_-°p

SLESERENEAE GibbsCAM Copilot
| pilot |

GibbsCAM Copilot is an Al-powered chat tool — a ChatGPT LLM (large language
model) that has been trained on a wide variety of source material relating to GibbsCAM.
It lets you access information without having to search through documentation or call
Technical Support. It can respond in any of the languages supported by the GibbsCAM
user interface. A “thumbs-down” feedback mechanism allows you to register
dissatisfaction with any reply. GibbsCAM Copilot works best when responding to
specific queries that are narrowly worded.

Please note that, because some countries’ laws relating to Al are not yet fully analyzed,
the GibbsCAM Copilot chatbot is disabled in some countries.
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Visualization and User Interface

GibbsCAM Copilot

<a

Connected.

The provided response is Al-generated and must be reviewed for accuracy, correctness, and relevance before use. By using this Copilot,
you acknowledge that you have read the Transparency Note and agree to the Terms and Conditions associated with GibbsCAM Copilot.

Rotary Hints: Op Sim / Machine Sim
indication of spindle direction

Where to find it:On the context menu for the Rendering dialog’s title bar, enable Show
Rotary Hints.
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Visualization and User Interface

E Y

Op Sim Rendering

IS DAT =

[ J=]
(=]
[ Ju]

G = B @

OB &kv @i
3 ] 1 KO

Show Time

Show Op#

Save to STL...
Save To Bitmap...
Create Facet Body

Skip Pecks

Skip Thread Roughing Passes
Don't Preload Sub-Spindles
Reload Simulation

Render Loop

Show Spinning Part

~  Show Skipped Ops
«  Show Rotary Hints

Sample Cut

Settings...

Quick and Powerful Improvements to

Selection

Edit > (Selection >) % Filter Selections

Where to find it:On the Edit menu, under Selection, click Z (Filter Selections) to open

the Selection Filter dialog shown below.
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Visualization and User Interface

Selection Filter iy !F. — %
Entities
Points
Free Points
Connectors
Terminators
Lines
Rapid and Feed
Circles
All
Curves
Dimensions
Text
Solids
Sheets
Edges
Profiles Maone
Hole Features et
PMI

All

Airfwall: | Air and Wal cs: Al

Items selected/deselected via the Selection Filter dialog can be stacked.

[ i
1 1
1 1

Deselect by Mouse Drag

Mouse Drag Mouse Drag

Complementing the existing command .- “Select by Mouse Drag” is a new command,
R

3“Deselect by Mouse Drag”. Each command has its own default keyboard shortcut,
such as Shift+drag to select and Ctrl+Shift+drag to deselect. These actions can be

stacked.

Bz

Containment and Overlap Mouse Drag: Left-to-right and
right-to-left

In previous releases, left-to-right mouse drag selection has been inclusive: It selects any
entity that is even partly within the drag region. A new feature is mouse drag selection

that is exclusive: The system selects only entities that are entirely contained within the

drag region.
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Visualization and User Interface

File > Preferences offers a new toggle (left-to-right inclusive containment as in
previous releases; or, instead, right-to-left inclusive containment coupled with left-to-
right exclusive containment).

Simulation default: Collision Checking,
Program Error Checking

Where to find it:In Sim dialogs, for new parts, notice that EE{ Collision Checking and
Program Error Checkingare now enabled by default.

Sync Manager during Sim: Graphical indicator
of Simulation progress

Where to find it:In the Sync Control dialog (except in Uniform view) while Simulation
is actively running, a red bar indicates the timeline of the simulation as it progresses
through the flows.
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Visualization and User Interface

Op Sim Rendering HE - x 2 & [Z] &
T1 1 TIO 2
i a = M =, pO — 1 —
O<cBkv 8% 8 2l |l P
s @1 vlka O B e = B
e AT= R : <INz
s | 52
Sync Control HE - 0Ox =y’ B
- 1
Bre v P, | b
o oy T4 1ld Ti5 2
J;-—F;y e | ‘l/‘ |_\£ 4 !1; _\=E 7
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2 gl E
=Pl
5114 52
T 1|l T17 2
=1 52
TT 1 T 2
2N =
5114 52

Ta

¥ s

1

T8

A <

=1

T19
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Op Sim Analyze Cut Part can use user-set
tolerances

Where to find it:With a solid selected, run Op Sim and then, after completion, click m
to open the Analyze Cut Part dialog and supply a value for Tolerance:

Analyze Cut Part [ 4‘ — X
© Undercuts on part body Show
() Undercuts on cut part Cancel

() Remaining Material

() Bemaining Matarial on part body

() Remaining Material Change

Tolerance 0.005 inches < I
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Visualization and User Interface

New Stop type in Simulation: Stop Before
Every Operation

Where to find it:In any Sim Rendering dialog, click Do open the Stops dialog. If you
want to review every operation individually, check the Stop Before Every Operation
checkbox before running Sim.

Stops SILEIE S
D xpeON
Condition Value Hit Count
] .ﬂ'Sb:-p At Part LoadUnload ]
] .ﬂ'Sb:up Before Operation 1 ]

[ ] - At Coeration 1 0
=¥ Stop Before Every Operation

New modes for Op Tile List: Columns for flows

Where to find it:Near the top of the Op Tile list, a new
set of buttons — £ ££ = — lets you set the mode for === &

¢

displaying flows: = B .f e
¢ - T1 1 - TiD 2

- [E]Show All Flows Y 1 %1 s IE 2
b | S'I\_ 32

8 d T 1l Tz 2

. Show Each Flow 1 2 1l [l B -
- L %51\ 52

. Sync Flow Mode ; ‘T\Eﬂlf g
L | %515 Ecusz

20



Visualization and User Interface

.
od] e e 2
[ |
i [
] o ]

2l é =] é |= ] & |
1 1 15 2 T2a 3 T‘_}: T‘;: s :’
1 T 1
Iﬂ%}m Iﬂ*ﬁ_}ﬂ < Iﬂ’ = = Ia*j’s’
, TIE 2 T3 3
= A
l Sﬁ 51' 51 52
Tza

(pzdp?

lE%%J“—‘
l 1 T23

T 16 2

(N

T23 3

T

Show Each Flow Sync Flow Mode

Quick-and-easy toolpath redraw

Where to find it:In File > Preferences > Interface, in the upper right of the pane, option
buttons let you specify the behavior of single-clicking an Op tile-tab or single-clicking
an Op tile.

You can set a preference to redraw toolpath in one easy action either when you click an
operation tile tab number or when you click an op tile itself.

Preferences

BF - x

- Display Interface

- Interface
- Machining Prefs

Window §f Tab Single Click Behavior

- File

- Import/Export

- Auto Save

- Coordinate Systems

- Post Processor Comments
- Com 5et-Up

- Int. Tooling

- 3-Code Editor Settings

- Additive

Dizlogs

(®) Do Nothing
() select Tile
() select Tile and Redraw Toolpath (Op List Only)

Tile Single Click Behavior
(®) select Tile

() select Tile and Redraw Toolpath {Op List Only)
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Tooling

Tooling

GibbsCAM 2025 brings further improvements to tools and tooling.

More tool parameters stored with tool data,
such as Ae and Ap

Additional tool cutting parameters like Ae (Cut Depth) and Ap (Cut Width) can be
stored with tool data. For tools that have such parameters imported from systems like
CPTL = CoroPlus Tool Library, these additional parameters are automatically available.

Where to find it:The Tool dialog and most process dialogs have a Tod [ button
that signals the presence of tool cutting parameters stored with the tool. Clicking this
button opens a dialog resembling the following:

Feeds and Speeds Table - Tool £1 o] [ — x
Entry# | Mame Surface Speed | Feed Per Tooth | Feedll Cut Width | Cut Depth

1 Enter Mame| 0 sfprm 0ipt 0ipr ™o =

< >

Order Tool

When cutting tools are imported via catalogs that GibbsCAM supports (such as
CoroPlus Tool Library, Harvey Tool, Helical Solutions, and Garr Tool), the GibbsCAM
Tool dialog presents a link: = Order tool
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Tooling

# Flutes 7
Length out of Holder 1
Tool Length Offset # 1

Cutter Comp. Offset 2 1

& Order tool

Tool Material  Carbide Insert  ~ [ Tool ID £ Tool Cutting Data M

Comment  HELIDO 880 LINE : 5880 F5N DO63-07-22-R13

Clicking the = Ordertool link directs you to the catalog of the specific tool library.

. M B G crwmwool-PocctDets x|

] & nitps/www.garrtool.com/product -detail

CHECK STOCK / REQL

GARR TOOL

High Performance Solid Carbide PRODUCTS ~ RESOURCES WHATSNEW Ol

« O B hitpsy//www.harveytool.com/products/tool-details-999031-c6 ¢
HARVEY PERFORMANCE  Gyamvey o Helical 001 [TITANUSA] jicomenos FyALDE

lk Enter Tool Number or Keyword C)\‘ OR
~yHARVEY TOOL e o e

HARVEY PERFORVANCE  Suamvey o Holicallll  [FICROI60] (THANUSA) commwos  vALDR

H ’- ’m Enter Tool Number or Keyword Q ‘ OR Find A Tool © Find apisiribuior £ Login/ Regisier

PRODUCTS HOWTOBUY CHECKSTOCK BUILDATOOL RESOURCES CONTACT

TOOL # 88718

2 Flute, Ball - 457 Helix, End Mills for Aluminum Alloys & Non-Ferrous Materials

Tool #: B8A718
Curtter Diameter: 0.3125" (5/16) Quantity Available: 12
- - Length of Cut: 1.2500" (1-1/4) Price: $66.80
S— Shank Diameter: 0.3125" (5/16) Customer Rating:
Overall Length: 3.0000" (3)

Advantages:Clicking the link takes you to the manufacturer’s catalog so that you can
view/inspect/compare the current tool and possibly import it from the manufacturer’s
ordering page for that tool. If you import from a catalog, GibbsCAM keeps track of the
tool’s item/catalog number and manufacturer.
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Posting and Output

Posting and Output

GibbsCAM 2025 includes improvements and enhancements to output capabilities.

TMS now supports full WFO (Work Fixture
Offset) functionality

Where to find it:In the Post Processor dialog, choose the Workfixtures tab.

Post Processor %IF — %
Z post DH

Options Workfixtures  Special Info

Use Workfixtures Restore Defaults

Options
Combine ldentical WFOs [ One WFO Per Part [] Use Local Shifts Restrict WFOs  []

®) By Operation (O By WFO (O By CS

Worlficture % Offzet Crientation &

.-- CEECRP IR = x-75v2520 | A101:0C101:0

0339=3 |v |9 X-79Y-25Z0 |A101:0 C101:0
e |3 3 Q339=20 |~ | &|X-25¥25Z0 A101:0 C101:0

a |4 5 0330=21 |~ | B[ ¥-25v2570 AT01:0 C010

Postprocessor support for machining
tolerance in solid ops

There are new commands for querying/outputting the operations machining tolerance,

so that you can learn (for example) whether you can turn on a particular kind of look-
ahead.

Please Note: This enhancement requires a post upgrade.
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Solids

Solids

GibbsCAM 2025 brings further improvements to solids and surfaces.

Edit Facet Bodies

Where to find it:The main tool palette has a new command:

18

Tools CAM —

Macros  OPTICAM  Help

(7
e
Surface Soli
Modeling Modeli

Clicking this Ocommand opens the FB Solid Modeling palette, which lets you edit
facet bodies using most of the tools you have for solid geometry, such as: Boolean
operations (union, subtraction, intersection); Slice; Offset/Shell; Separate; Unstitch
Body; Shrinkage; History; Check Body Validity; and calculations of surface area and
volume. Just as with solid bodies, each modification to a facet body is preserved in its
History Tree. When a facet body is combined with a regular (B-Rep) solid body via
Boolean commands, the result is a facet body with a history.

The following new functions are specific to facet bodies: [ Heal Facet Bodly; %EJSmooth
Region; %Reduce Complexity; g@Refacet; and Q@Tesselate.

Collision Avoidance of Fixtures

Where to find it:In many process dialogs, the Solids tab now offers a new checkbox:
Avoid IT Fixtures. For Advanced 3D processes, this checkbox is in the Boundary tab.
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Solids

Process #1 Contour

O@FEHF - x

Cuntuur] Mill Feature ~ Solids lﬂpen Eidﬁl Df'Fset] Entrw‘Ex'lI:]

Cutting Direction

(®) Climb

() Conventional

Rough
Finish

Advanced Settings E |

Project 2D Toolpath

Surface Stock 0.02

Awvoid IT Fixtures

(") Depths from Feature
(®) Depths from Tool

SEER » B

Rapid In bz I 0 |

(®) Desired 7 Step 0.035
: i 0.00039

When this checkbox is enabled, collision avoidance is aware of both Intermediate
Tooling fixtures and workspace fixtures, allowing it to avoid gouging clamps, jigs, etc.

Also: In parts whose MDDs define Clearance Volume, clearance transition moves now
automatically avoid collisions with all types of fixturing if possible. For Advanced 3D
processes, you can fine-tune this by entering a value in the new Fixture Clearance text

field in the Boundary tab.
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Miscellaneous

Miscellaneous

System requirements are unchanged from GibbsCAM 2024:
OS: Windows 10, Windows 11, or Windows Server 2022.
CPU:Intel Core ig, i7, or i5 with four or more cores; or AMD Ryzen or Threadripper
RAM: 16+ GB
Video card: NVIDIA video card with 4+ GB of video memory

Third-party library support

VoluMill 9.6 is now supported.

Because GRANITE does not support importing the latest PTC Creo files, the legacy
GRANITE import options have been removed; the Spatial options are retained.

Note: Add-ins for Cimatron 15 and 16 are still supported, but they no longer appear in
the InstallShield Wizard, because they are now installed with Cimatron rather than
GibbsCAM.

Copying/pasting of solids preserves colors
and other attributes

When you copy-and-paste a solid, all attributes on the solid, faces, and edges are now
preserved, including not just Color attributes but also attributes of types Feature, Real,
Integer, and Text.

How to use it:Open two sessions of GibbsCAM. In the first session, open a GibbsCAM
part that has attributes (such as color or PLM). Copy part or all of it and then paste into
the second session.
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Miscellaneous

NLO License borrowing with

checkout/return/expiry parameters

Users can now check out an NLO license for a specified time period, then disconnect
from the network. This allows users to borrow licenses, disconnect, move their laptop,
and keep using the GibbsCAM products even when the license server is stopped.
Borrowed licenses can be returned manually, or they can be set to expire after a set

time.

Where users can find this option: Under File > Preferences > Interface, click License

Options; then, in the License Manager dialog, click Start Roaming.
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Op Manager, Process Manager support for
VoluMill data fields

Where to find it:Open a VoluMill model and access Operation Manager or Process
Manager, as illustrated below.

Op Manager - All Ops o E - x
@A H 2 e 2| EH e
Op# | Op Type | Depth |Z Step| #Passes | EFeed Speed | MaxRPM| CFeed | Stock| Sstock| ZStock| Xstock| T1 | CBreak| Pitch| Entry Line| Exit Line| Entry Rad | Ex &

52 |Contour | -0.1 .1 = 150 | 2500rpm |- 30.0ipm | -0.02 |- 0 = 12)- = 0.06 0.06 0.03 0
53 VquMiII_] 024 2.0 31 150.0 10000 rpm - 300.0ipm 0 0 0 = Z = = = = = =

L
IJ( >
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Op Manager, Process Manager support for
many 5-Axis data fields

Where to find it:Open a 5-Axis model and access Operation Manager or Process
Manager.

MDD limits on maximum spindle RPM

MDDs in GibbsCAM 2025 can set a maximum spindle RPM. Exceeding the maximum
RPM will result in a program error.

Where to find it:Machine Manager > Live Tool

Tool Station tab (M Live Tool): Max RPM Max RPM I:I

Part Station  Orientation

Where to find it:Machine Manager >

. Spins Part
Part Station tab (M Spins Part): Max RPM i

Max RPM |:|
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5-AXis

This chapter discusses the following enhancements to 5-Axis in GibbsCAM 2025.

Note: For illustrations and full descriptions of 5-Axis functions, see the 5-Axis guide.

Multiblade

Edge Rolling for Leading and Trailing Edges - With this enhancement, leading and trailing
edges can now have their own edge rolling settings. This gives users more flexibility and
allows them to define how the leading and trailing edges should be individually
machined.

Process #1 5-Axis Parameters

Options  Surface paths Part definition Tool axis control  Link Edges

Leading edge Trailing edge

Edge rolling

Automatic Trimmed by length

Full (without trimmming) 2.5
Auto (trim by tool radius)

Trimmed by length

Trimmed by angle

Edge extension

Tangential 2

Radial

Feedrate for Leading/Trailing Edge - The toolpath can now have different feedrates at the
leading and trailing edges, providing greater control. This results in improved surface
quality, more consistent cutting, and smoother machine tool movements.
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Process #1 5-Axis Parameters
Options Surface paths Part definition Tool axis control  Link

Calculation based on Multi blade machining
Pattern
Part Impeller
Machining Roughing

Strategy Offset from hub

Sorting
Method One way, start from leading edge

Ordering Left to right

Depth step Stepover

() Maximum number () Maximum number 10

© Maximum distance . © maximum distance 127

First cut Rest material

Intermediate slices
() Avoid incomplete depths

First cut spindl d %
| aa © Rough all depths

@ First cut feedrate %

Final cuts

Number of final cuts

Final cut stepover

Core Technologies / Linking

Fade Lead In/Out - This new feature adds a new lead type called “Fade” that moves slowly
away from and towards the machining surfaces.

Automatic as Default - This new feature changes the default settings for the linker. Setting
the default for clearance to “automatic” results in more successful toolpath generation
without any user interaction for clearance inputs. This reduces the programming time.
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3-Axis Machining / 3-Axis

Machine Flatlands after Each Slice - The new option 'Machine Flatlands after Each Slice'
machines flatlands on top surfaces after each slice. This option, along with DHC,
enables the tool to reach deeper pockets, which would otherwise not be possible to
reach.

3D Contact Point Boundary for Finishing - The new implementation of the 3D contact point
boundary accurately limits the finishing toolpath to the 3D containment on the part,
improving the surface quality. Users only need to define the cut area on the actual part,
and the calculation automatically limits the toolpath to ensure the tool contacts the
surface exactly at all the points. Users no longer need to recreate the containment or
manually add the offsets.

Optimal XY Angle for Flatland Milling - An option to optimize the XY angle has been added
to the flatland toolpath. It adjusts the angle for separate regions independently to
optimize material removal and surface quality. This is achieved by aligning the parallel
passes with the longest length of the relevant area.

Ordering by Region - The parallel cuts toolpath can now be generated using new region-
based ordering. This provides better surface quality as there are no engage or retract
moves in a region. Each region is milled completely and then the tool moves to the next
region. This option is offered in addition to the shortest path ordering option.

Store Contact Point Normals - This new enhancement for 3-axis finishing toolpaths stores
the contact-point normals along with the toolpath in the structure. These contact-point
normals can be used subsequently for 3D cutter compensation or tilting in the 3-axis
finishing strategy.

Outside-In Ordering for Flatland Milling - This enhancement enables flatland toolpath to
order the passes from the outside to the inside of the island or region. This helps to
improve surface quality and greatly increases the tool life, because the tool no longer
engages directly on the surface from the top.

3D Machining / 3-Axis

Improved Stock Aware Linking - The stock awareness for linking has been improved. In
addition to checking against the part, in-process-stock is now also checked during
linking motions. This minimizes the number of link and ramp motions while
guaranteeing a collision-free toolpath.
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Optimized Link Height - The improved in-process-stock awareness optimizes link heights
and keeps them to a minimum. This reduces linking motions by up to 30% and
therefore reduces machining time while maintaining machining safety.

Where to find it:tab "Link" > dialog "Retracts" (lower left) > checkbox "Optimize lead
and link distances"

Optimized Ramp Height - The improved in-process-stock awareness optimizes ramp
heights and ensures the ramps start exactly at the height of the in-process-stock. This
reduces air cutting and machining time while ensuring optimized entry.

Where to find it:tab "Link" > dialog "Retracts" (lower left) > checkbox "Optimize lead
and link distances"

Smoothing Control for Offset - Offset toolpaths for complex and detailed features are
smoothed out while preserving the original last contour. This reduces unnecessary
jerking motions caused by changes in acceleration and deceleration during the
machining process and ensures constant, high-speed roughing.

Where to find it:tab "Roughing" > dialog "Advanced" > checkbox "Smooth contours" /
textbox "Smooth deviation (stepover %)"

Orthogonal Extension for Leads - In addition to the tangential extension for lead motions,
a new orthogonal extension has been added for profile passes. This is especially useful
when an extension is necessary for switching to CRC mode on the CNC machine,
because it minimizes the space needed to perform the switch. This is particularly
convenient when machining small pockets.

Where to find it:tab “Surface Paths" > dialog “Profile Pass" > textbox “Orthogonal line
length"

Corner Detection Threshold - The corner detection threshold defines the maximum
adjacent angle between adjoining faces for a pencil toolpath calculation. The toolpath is
not calculated for corners with angles larger than this threshold. By adjusting the
threshold, the user can optimize the toolpath and avoid unnecessary or undesired
machining.

Where to find it:tab “Surface Paths" (area"Surface Quality) > checkbox “Corner detection
threshold"

Optimal XY Angle - An option to optimize the XY angle has been added to the parallel
cuts pattern. It adjusts the angle for separate regions independently to optimize
material removal and surface quality. This is achieved by aligning the parallel passes
with the longest length of the relevant area.

Where to find it:tab “Surface Paths" (area"Pattern") > checkbox “Optimal machining
angle in X,Y"
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Advanced Filtering for Finishing - A new Inscribed circle option has been added to the
filtering options for finishing cycles. This provides additional user-control for filtering
unnecessary toolpath segments.

Where to find it:tab “Surface Paths" (area"Area") > dialog “Filtering" > (Filter by:
Regions) > "Type" pulldown choice "Inscribed circle"

Spiral Machining for Undercuts - Constant Z undercut machining now offers an additional
spiral ordering option for generating a spiral toolpath for undercut machining. This new
option ensures a continuous, seamless machine motion and thus improves machining
performance as well as surface quality.

Where to find it:tab “Surface Paths" (area"Sorting") > "Cutting Method" pulldown choice
"Spiral”

Report Minimum Shaft Length - A new Report minimum shaft length feature is now
available for finishing cycles. It calculates the minimum shaft length required to reach
all the areas to be processed within the specified machining height limits. The tool can
be adjusted to ensure collision-free machining.

Where to find it:tab “Gouge Check" > dialog “Advanced parameters" > checkbox “Report
minimum shaft length"

Improved Stock Aware Linking - The stock awareness for linking has been improved. In
addition to checking against the part, in-process-stock is now also checked during
linking motions. This minimizes the number of link and ramp motions while
guaranteeing a collision-free toolpath.

Where to find it:tab “Surface Paths" (area"Pattern") > DHC=dialog “Dynamic Holder
Collision" > checkbox “Check with in-process stock"

Improved Peg Loops - The corner peg loop strategy has been improved. It now merges
the peg loop segments into offset contours to avoid changes in the machining direction.
This improves machining performance and increases tool life.

Where to find it:tab “Roughing" > dialog “Advanced" > checkbox “Smooth Links"/textbox
“Smooth link gap size (stepover %)"

Adaptive Roughing

Zig-Zag Threshold - The new Zig-Zag Threshold ensures that corner regions smaller than
the given threshold are connected via the one-way trochoidal method, while zig-zag
linking is maintained for longer toolpath contours. This improves the machining
conditions while keeping the toolpath length short.
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Where to find it:tab “Surface Paths" (area "Sorting") > checkbox “Zigzag threshold" /
textbox “x Tool diameter”

Start Point Control -

Core Technologies / Tilting Core

Strict Preference for Automatic Tilting - A new feature is now available for the Automatic
tilting gouge check strategy. This feature restricts the degree of freedom for collision
avoidance to one. This allows you, for example, to maintain a constant table rotation
from the input data and use only the tilt axis to avoid collisions. Previously, the rotation
also contributed to collision avoidance, which meant the table rotation sometimes
showed reversals.

Where to find it:tab “Gouge Check" ("Tilt Tool"+"Automatic") > dialog “Parameters”
(area "Behavior") > "Preference” pulldown choice "Rotary tilt (strict)"

2D Machining / 2-Axis

External Sharp Corners for Open Ends -

3D Machining / 3-Axis

Flatland Ignore Gaps -

Report Minimum Shaft Length -
Independent Filter for Closed and Open Contours -
Corner Peg Height Control for Ball and Bull Mills -

Parallel Cuts Ordering Enhancement -

Multi-Axis Roughing / Rotary Machining
Roughing

Leads for Roughing - This enhancement adds lead-in/out options for rotary machining
roughing toolpaths. These additional motions ensure the smooth entry and exit of the
tool into and out of the material. This is especially useful for open pockets and also for
rest machining operations. It generates smoother transitions and ensures optimum start
points on open contours. Tool wear and the risk of tool damage are also reduced.
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Multi-Axis Roughing / Area Roughing

Minimize Links - This enhancement reduces the number of ramps in the multi-axis
roughing strategy by optimizing the start points for closed contours. This means that
some ramps are removed and the tool, in these cases, engages from previously cut
passes. This reduces the total cycle time of the operation while increasing tool life.

Avoid Small Profile Ramp - This improvement enables the minimum size of profile ramps
to be controlled by a parameter. This helps to avoid small profile ramps, making it
possible to use tools with wider non-cutting areas. It also improves tool engagement
efficiency, and larger ramps means less ramping time.

Trim Line Ramps - With this improvement, line ramps are now trimmed to the stock. This
ensures that the ramp length is appropriately defined according to the available stock,
which in turn reduces the overall engagement time.

Multi-Axis Roughing / Geodesic Machining

Improved Corner Smoothing - This option allows smoothing corners in toolpaths. This, in
turn, leads to better surface quality and also to shorter machining time, because the
tool does not need to decelerate and accelerate abruptly.

Improved Medial-Axis Cuts - This feature makes medial axis cuts more powerful. With this
option, users can add additional medial axis cuts that are either merged with the main
cuts or added as finishing cuts. This greatly improves surface quality and reduces the
manual effort required to clean up the cusps afterwards.

Multi-Axis Roughing / Wall, Floor, and Rest
Finishing

Stepover by Cusp Height - This enhancement adds an option for the user to define the
stepover based on the cusp height for advanced tools, such as barrel mills. With a cusp-
based stepover, users can easily setup operations and avoid mistakes in manual
calculations.

Tool Segment Selection for Tilting - This feature enables users to define tool tilting using a
tool segment when working with advanced tools such as barrel tools. This gives users
greater control over the tilting range as well as the tool contact point for operations.
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Multi-Axis Roughing / Surfaces

Slot Mill Enhancements - This enhancement introduces a new option for slot mill tools.
Users can now add chamfered edges to the tool. This ensures full coverage of available
slot mill types.

Multi-Axis Roughing / Swarf Machining

Gouge Checking against Individual Tool Parts - With this update, it is now possible to select
individual parts of the tool for collision checking. This feature gives the user more
flexibility and control over which sections of the tool are included in collision checking.

Multi-Axis Roughing / Turn Milling

Radial Cuts - This new option adds a completely new cutting approach to turn milling.
The 'standard’ turn milling cuts are spirals that are created in the axial direction and
increment (depth step) in the radial direction. The radial cuts option does the opposite:
the cuts propagate slice-wise in the radial direction to the final cutting depth while a
sidestep is applied to reach the next slice.

Multi-Axis Edge Finishing / Deburring

Corner Arc Support for Chamfer Tools - This new enhancement creates a continuous
toolpath around inner and outer corners when using a chamfer mill without any
intermediate links for 5-axis deburring. This reduces the linking motions and hence the
overall cycle time for chamfering.

Multi-Axis / Automatic 3+2-Axis Roughing

Marker in 3+2 Roughing Simultaneous - Linking for the start and end of 5-axis transitions.
Clearance blend spline feedrate for 3+2 roughing

Multi-Axis / Deburring

Allow Asymmetric Edge Shape -
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Multi-Axis / Geodesic Machining

Containment Cuts Order -

Multi-Axis / Multi-Axis Machining

3D Containment Curve Offset -

Sort by Regions/Lanes - Allows the user to choose a sorting method for the finishing
cycles.

Multi-Axis / Multi-Axis Profiling

Advanced "Run tool at contact point" -

Multi-Axis / Surfaces

Leads - Tool Orientation Normal To Lead is a new orientation type for leads that keeps
the tool normal to the toolpath at all positions.

Leads - Along Tool Axis is a new lead type that follows the tool axis direction.

AT 2.0 - For Automatic Arc Leads With Automatic Tool Orientation and Barrel Tools
allows AutoTilt 2.0 (AT 2.0 to work on automatic arcs for barrel tools.
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